NEDARC Workshop “Analyzing Your State’s EMSC Performance Measure Data”
Performance Measure 76 & 77: Quality Assessment

Performance Measure 76 & 77: State/Territory Quality
Assessment

The numbers needed for the Performance Measures 76 & 77 EHB entries have been calculated, but you
may want to do some quality assessment to better understand your hospital data. For example, for each
EMSC component, what is the percent of inter-facility guidelines that contains that component? Which
components are most often included in inter-facility transfer guidelines? Which components are least
often included? Which hospitals are in the process of developing inter-facility transfer guidelines &/or
agreements? When will these in process documents be completed—do you have time to get involved
before they are finished to ensure they don’t exclude pediatrics &/or include the EMSC components?

I. Quality Assessment: Analyze Individual EMSC Components for PM 76

1.

o M w D

The cleaning and analysis for the Performance Measure 76 EHB entries should be completed
prior to doing this analysis because the following steps build upon that cleaning and analysis.

Insert a new worksheet and call it Data QA.
Type Guideline Component in cell Al and resize the column.
Go to the GuidelinesAgreements worksheet tab and clear all filters so that all data are showing.

For each EMSC component, you will need to calculate the number of hospital inter-facility
transfer guidelines that include each component. Go to the bottom of your dataset on the
GuidelinesAgreements worksheet tab and skip at least 5 rows after the last record.

(Note: you will need to skip at least 5 rows so you do not overwrite your PM 76 EHB labels and to
distinguish between calculations and when applying filters.)

4.

In the sixth blank row after the last data record, type c b £ F G

~| guideli ~| compor - | compor| ~ | compor - | compor ~

Component Numerator in the cell in the guidelines = - = = 5
column. (see example picture to right)

Then type in Component Denominator below the

nU merator ComponentNumerator
ComponentDenominator :!

ComponentPercent

Then type in Component Percent below the

denominator.

If needed, resize the guidelines column at this time.

7.

Click in the cell to the right of the cell where you just typed Component Denominator.

a. Click on the fx
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8. After you click on the fx, an Insert Function box will [insert Function 12
appear. In the Search for a function: box, type in the Wh . i
word countif. = . Ce D

) Or select a category: |Most Recently Used
a.. Then CIICk On the QO bUtton Select a function:
.
b.  Then click the OK button located at the bottom o ]
of the Insert Function box. Fo :
HYPERLINK
COUNT 2
COUNTA(valuel,valuel,..)
Counts the number of cells in a range that are not empty.
Help on this function

9. A Function Arguments box will appear with the cursor blinking in the Range box.

10. We need to use datasheet references and dollar signs in the front of the column references in this
function so that these formulas will still be valid when we copy these cells to the Data QA
worksheet. e

| F (> xQ NTIF(GuidelinesAgreements!$D$2:m)
a- Type GUIdeIIneSAgreementS! and 1 'Dele‘ie;_:' hospital : -:'_guidelines '_component_foles_y_n
then the range of the data for S e i =)
guidelines in the Range box with § 7 4} coo =
Symbols around the data range. In the 35: | CI:;IEI:: i.l:fehnes»\greementslSDSZ:E.DE# : i‘t;’\’jw}'\’;'\’;“ﬂ'\’i'\’j"f}'\’i'\
example picture the data starts wr Al -
. . r Counts the number of cells within a range that meet the given condition.
in cell D2 and ends in cell D47 | SLITE I e
b 3 defines which cells will be counted.
- $D$2:3D$47 ol 4
a3 gl Formula result = 34
b. Type “Y” in the Criteria box. 2 4 eoon s oo (—— e
a6 R T Wid bates RegonsTMedica T Carter 7 v
c. Thenclick onthe OK button located " = weringwinoutanetsosprsl v Y
at the bottom of the Function |
50
Arguments box. 51
=
54 Component Numerator
55 Component Denominator|1ts!SD52:5D547,"Y" )
56 Component Percentage

11. A number should appear in the cell. This is the total number of hospitals in your dataset that have
inter-facility transfer guidelines.

12. Copy this formula horizontally across all of the component columns (component_roles_y n
through component_directions_y_n).

(Note: The same number should be the in Component Denominator for each of the components.)
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13. component_roles_y _n numerator:

Performance Measure 76 & 77: Quality Assessment

Click in the cell to the right of the cell where you just typed Component Numerator.

a. Click on the fx [nser Functon =)
Search for a function:
b.  After you click on the fx, an Insert Function box will J:wu"ﬁf)

appear. In the Search for a function: box, type in the

word countif.
Then click on the Go button.

Or select a category: |Most Recently Used E

Select a function:

=
z
=]

-

HYPERLINK
COUNT il

COUNTA(valuel,valuel,..)
Counts the number of cells in a range that are not empty.

Then click the OK button located at the bottom
of the Insert Function box.

Help on this function

—

14. A Function Arguments box will appear with the cursor blinking in the Range box. We need to
use datasheet references and dollar signs in the front of the column references in this function so
that these formulas will still be valid when we copy these cells to the Data QA worksheet.

a. Type GuidelinesAgreements! and | cour HOFTar, -COUNT'F(GU'de'[nesAqreements!@
then the range of the data for | > ; E - F ; G
. 1 |guidelines ~  component_roles_ y n | | component_facility y n | ¥ component_staf]
component_r_oles_y_n in th_e BN e : = =
Range box with $ symbols infront > |——
Of the rOW range In the example ey Range Guidelinesngreemems!E$2:E$ 8 e s e e e e e s
picture, the data starts incell E2 .2, Crteria | -
and endS in CE" E47 9 E$2E$47 :; : Ccuntsﬂﬂenumberof:ellswiminarangeﬂﬂatmeetiﬁegiven:onji:on.
) ) ) 33 : Criteria idse%ﬂ:ecsoxg:g?ncélﬂsﬂ:velufggmcgjnzl;mber,expression, or text that
b.  Type “Y” in the Criteria box. iE
- 2 N Formula result = 34
c. Then click on the OK button CI |
located at the bottom of the A
Function Arguments box. a6 Y Y N N
a7 ¥ Y Y ¥
48

WARNING! If you decide to use the variable name form the Use in Formula option under the Formulas tab instead
of typing in the range, you will not be able to drag the formula across to the other component numerators.

15. Other component numerators:

a. Copy this formula horizontally across the rest of the component numerators (i.e.,
component_facility_y n through component_directions_y_n).
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16. component_roles_y_n percent:

The first component listed in the dataset is component_roles_y n

a.
b.

C.

Click in the cell to the right of the Component Percent (component_roles_y n column)
Type inan =

Then click on the Component Numerator value for component_roles_y_n (cell E54 in
example picture)

Typea/

Then click on the Component Denominator value for component_roles_y_n (cell E55 in
example picture)

COUNTTF ~ (3 X o fe|=E54/E55
D E

1 guidelines | * component_roles_y_n | ¥ cor
53|

54 ComponentNumerator | 3 :11

55 [Component [Jv:ar‘u::armnatrt:ur.-;I”;__;;}d_;;;;;ﬂ_;;;g_a__fjL
36 |Component Percentage |:E54IE55 |
57

A WARNING! Do NOT use the actual values for the numerator and denominator for this step because if you do, the
& percentage will not update as you clean your dataset during the follow-up process.

> @ =

Then hit the Enter key.
A number will appear in the cell.

Click back on the cell with the number.

Then click on the % symbol in the Home tab and it will convert the number to a percentage.

17. Other component percents:

a.

Copy this formula horizontally across all of the component columns
(component_facility_y_n through component_directions_y_n).

You now have the percent (how often) each component was listed in the total number of
hospitals with inter-facility transfer guidelines. For example, in the picture above, the

EMSC guideline component_roles_y n (Defined process for initiation of transfer, including
the roles and responsibilities of the referring facility and referral center) is present is 100%
of the 34 hospitals with guidelines. The EMSC guideline component_directions_y n (Plan
for provision of directions and referral institution information to family) is present in 68% of
the 34 hospitals with guidelines.
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19) Select and copy the entire area from Component Numerator to the last percentage listed for
component_directions_y_n.

f/ Home Insert Page Layout Formulas Data Review View Add-Ins Acrobat ‘tﬁ - =
# cut e = EEalir= o = = EF:I HE (el | Em Fx | T Autosum - A? l?a
= Calibri 11 | AT AT || =||®~| SwmapTet General &5 i | 5 & ‘_g_] &) Fil- z
iste PR )| [ | ) i= 5=|| B Merge & Center~ ||[§ = % » |[%@ 93|/ Conditional Format  cell Insert Delete Format | Sort & Find &
< Format painter || T [ Sveer | F| e l e e - - | c2Cleart  Fifter~ Select~
Clipboard {F Font F} Alignment {F Mumber T Styles Cells Editing
C53 -3 I ‘ ComponentMumerator
c | D E E G H I J K -
guidelines _~|component_roles_y_n |~ |comp - 1v/comp |~ comp | = | comp _recl - |comp _ca v | comp _belol ~ | comp _directions_y n |~/ met PR~
ComponentNumerator 34 24 27 32 32 31 25 23
ComponentDenominator 34 34 34 34 34 34 34 34
ComponentPercent 100% 71% 79% 94% 94% 91% 74% 68%|

20) Go back to the Data QA worksheet tab and click on cell B1.

21) Then choose Transpose from the Paste icon located on the Home tab.

Home Insert

q
e 2o
aste
= # Format Painter 1

[ Paste
E@[ Formulas

Paste Values

o

Mo Borders
Transpose
Paste Link
iﬁ Paste Special...
[Z§ Paste as Hyperlink
[8 | As Picture 3

22) Bold Guideline Component, Component Numerator, Component Denominator, and Component
Percent.

23) Go back to the GuidelinesAgreements worksheet tab.

24) Select and copy all of the component names listed on the header row: component_roles_y n through
component_directions_y_n.

25) Go back to the Data QA worksheet tab and click on cell A2. i tome. W
=0 | cut iz
——! |25 o

26) Then choose Transpose from the Paste icon located on the Home tab. | ™ 3 rormateamer ||
L:E Paste

=T

L Formulas

Paste Values

: Transpose
Paste Link
% Paste Special...
fa Paste as Hyperlink
@ As Picture 3
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27) Click on cell A2 and then select Filter from the Data tab.
28) Resize columns A, B, C, and D to show all of the component names as well as column headers.

29) Now you have a data table that you can filter from largest to smallest value or smallest to largest
value to rank the individual components.

(Note: Refer to your data dictionary if you do not remember which component goes with which
component variable name.)

I1. Quality Assessment: No Guidelines and/or Agreements

We will use filters to determine which hospitals will require follow-up to assist them with making
their inter-facility transfer guidelines and/or agreements.

1. Guidelines

a. Go to the GuidelinesAgreements worksheet and clear all filters and make sure you are at the top
of the dataset.

b. Click on the box above row1 and to the left of column A.

Bgtment i S = —

Home Insert Page Layout Formulas Data
[ T B = s V| F
Bl B =l B
¥ Gridlines v H
Normal| Page Page Break | Custom Full

Layout  Preview Views Screen g
Workbook Views Show/Hide

L_\ Al - ﬁr‘ ResponselD
A B d
1 Resporl ~ | hospital |+ | guide
2 34564 My Goodness Medical Center Y
3 | 34568 Keep on Truckin Medical Center inDe
a4 34617 Stitches in Time Hospital iy

This will select the entire spreadsheet in this worksheet

c. Once you have everyone selected, you will need to resize the ROWS (not columns) to see the
complete contact information for each hospital. To resize the rows, move your cursor to any line
between two rows and double left-click with your mouse.

| Al - I ‘ ResponselD | Al - £ | ResponselD

Pl a B € 0 Pl A B £ D
1 |Respon ~ hospital = guidelil ~ | comp 1 |Respon ~ | hospital = | guidelil ~ | compg
i 34564 My Goodness Medical Center Y ¥ My Goodness Medical Center
3 34568 Keep on Truckin Medical Center inDev _> 3500 § 4th St, Leavenworth, 55578
4 34617 Stitches in Time Hospital Y N Osto Tyrnith, Director Inpt/Outpatient
5 34663 It's A Crewel World Hospital N Svs., 555-555-5584,
6 34680 Jail Time Memorial Hospital Y Y 2 34564 Osto.Tyrnith@place.com ¥ Y

Keep on Truckin Medical Center

100 Crestvue, Milton, 55580

Arix Garoon, Emer. Prep Coordinator,

3 34568 555-555-5561, Arix.Garoon@place.com inDev
Stitches in Time Hospital

2420 G Street, Belleville, 55557

Karreal Zaine, R.N., 555-555-5598,
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Filter guidelines for “N” and “inDev”.

You have now identified which hospitals in your state need help developing inter-facility
guidelines. You can assist them by sending them a template guideline document with the
required EMSC components.

Clear your filters.
Click on the box above rowl and to the left of column A.

Move your cursor to the data area and right-click with your mouse to get tool option box. To
open. Select Row Height... from among the options.

[Meaori -1 - A A8 -% » Fespo
[Blr =@-&-A- 98 E
1 [Respon ~ [ hospital

& | Cut 5
23| copy 19557
| Paste Y
| Paste Special...
2
Insest nter|
Delete
Clear Contents rdi
3% Format Cells... pla
Row Height... |
Hide 1557
Unhide pod
q*,—:mvmmmm@matm

A Row Height box will appear. Type 15 in the space and click OK.

T AL R A e
3500 S 4th St, Leavenu

5Vs., 555-555-
2 34564 Osto.Tyrnith @
Keep on Trucki
100 Crestvue,
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2. Agreements

a.

Go to the GuidelinesAgreements worksheet and clear all filters and make sure you are at the top
of the dataset.

Click on the box above row1 and to the left of column A.

B e‘a [ = —
Home Insert Page Layout Formulas Data
f = == =1 E= Ruler v F
ESEE: j FEa5E IJ B

¥ Gridlines v H

Normal| Page Page Break | Custom Full
Layout  Preview Views Screen

Workbook Views Show/Hide

L\ Al - fe ‘ ResponselD
A B d
1  Resporl ~ | hospital |+ | guide
2| 34564 My Goodness Medical Center Y
3 | 34568 Keep on Truckin Medical Center inDe
a4 34617 Stitches in Time Hospital iy

This will select the entire spreadsheet in this worksheet.

Once you have everyone selected, you will need to resize the ROWS (not columns) to see the
complete contact information for each hospital. To resize the rows, move your cursor to any line
between two rows and double left-click with your mouse.

| Al - § }‘I-| ResponselD
==
- Pl A B e D
Al - I ‘ ResponselD 1 [Respon - | hospital |~ guideli| *| compol
Pl a B C 0 My Goodness Medical Center
1 [Respon ~ hospital ~ guideli| v |comp 3500 5 4th St, Leavenworth, 55578
2 34564 My Goodness Medical Center ¥ ¥ > Osto Tyrnith, Director Inpt/Outpatient
3 34568 Keep on Truckin Medical Center inDev Svs., 555-555-5584,
4 34617 Stitches in Time Hospital Y N 2 34564 Osto.Tyrnith@place.com ¥ Y
5 34663 It's A Crewel World Hospital N Keep on Truckin Medical Center
6 34680 Jail Time Memorial Hospital Y Y 100 Crestvue, Milton, 55580
— . - Arix Garoon, Emer. Prep Coordinator,
3 34568 555-555-5561, Arix.Garoon@place.com inDev
Stitches in Time Hospital
2420 G Street, Belleville, 55557
Karreal Zaine, R.N., 555-555-5598,

Filter agreements for “N”” and “inDev”.

You have now identified which hospitals in your state need help developing inter-facility
agreements. You can assist them by sending them a template agreement document.

Clear your filters.

Click on the box above row1 and to the left of column A.
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h. Move your cursor to the data area and right-click with your mouse to get tool option box. To

open. Select Row Height... from among the options.

B2
=

ma

£

{3 | Copy =
Du

(—- 10 - 1 - | LA oA =R el

Cut r

Paste
Paste Special...
Insert

ni:
Delete
Clear Contents e
Format Cells... pl
Row Height...
Hide 155
55

Unhide

I. A Row Height box will appear. Type 15 in the space and click OK.
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